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SECTION 1 

Context 



Tip #1 
Write for the FUTURE 
 
It is a misconception that resumes are about your past. Resumes are about your FUTURE. 

In other words, your resume will work if you think about what a potential employer would want to know 
about how you WILL perform. What experience do you have that will enable you to make a contribution 
to their firm or organization? 

If you are writing from the perspective of the FUTURE, here’s what will happen: 

1. You will write detailed bullets that demonstrate your capability to achieve measurable results. 
Your readers will infer that you can produce similar results for them. 

2. You will think about the purpose and priority of each item on your resume, then choose and place 
your sections and bullets accordingly.  

3. You will delete anything that is irrelevant or of minimal importance to your future.  
4. You will include positions from as many years back as necessary to share information that’s 

relevant to your next position—there is no absolute rule about how many years to include! 

Keep reading for more resume tips that will help you write a well-formatted, attention-grabbing, future-
based resume! 

 

Tip #2 
Know Your Target. 
 
If you’re not sure what position you are aiming for, how are you possibly going to get it? 

Make sure you know what your ideal job is, and write your resume as if you are going 100% for that job. 
If there are two types of jobs you want, write two resumes. If there are three types of jobs you want…? 
You guessed it!  

One size does NOT fit all in the world of resumes! 

If you try to write a “universal” or “general” resume you will almost always fail. You will feel scattered 
and unfocused as you write, and you will most likely not succeed in obtaining job interviews. 

If you are applying to multiple types of jobs because you are not sure what direction you’re headed in, 
take a step back and consider whether you might want to get some career coaching before you sit down to 
write your resume or pay someone else to write your resume. Clarity of purpose is key when you start 
your job search. You might still apply to more than one type of job; just be clear about your intention 
when doing so. 



If you want a recommendation for a career coach, contact us at TEESupport@TheEssayExpert.com. We 
will give you a list of people who can help. 

You might want to try some exercises that you can do on your own. We recommend Mary Elizabeth 
Bradford’s Award-Winning program, the Job Search Success System, which provides worksheets and 
audio modules to support you through every step of your job search. 

Once you know your target or targets, you can begin tailoring your resume. Many of the tips in this book 
will help you think through how to match your experience to your desired job description(s)! Part of 
knowing your target is determining whether it is an appropriate fit for your skills and experience. Take an 
honest assessment of whether you are a match for the position. You might discover that you are not the 
best fit and that your energy would be better spent on a different application. An article in Forbes 
Magazine covered this issue well: 3 Things That Will Get Your Resume Thrown in the Trash. While it’s 
good to aim high, it’s important to achieve a balance between reaching for the next challenge and barking 
up the wrong tree. 

 

 

mailto:TEESupport@TheEssayExpert.com
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SECTION 2 
Getting 
Started   



Tip #5 
How Long Should My Resume Be? 
And How Many Years Should I Include? 

A question that comes up extremely frequently with job seekers is whether their resume can be more than 
one page—or more than two pages. During my Top 10 Ways to Make Resume Writing FUN webinars I 
am often asked questions such as, “Can my resume be automatically rejected by a company simply for 
being too long?” I am happy to report that these fears are for the most part unfounded. 

Let’s get it from the horse’s mouth: Career Directors International conducted a survey of recruiters, 
human resource professionals and hiring authorities, entitled Global Hiring Trends 2012. The report is 
summarized in my blog article, What Do Recruiters Want in a Resume? Answers Within… 

I encourage you to read the entire report if you can. It is a quick read, full of illustrative graphs and charts. 
Many topics are covered, including recommended resume length.  

Here’s what the report found: 

Page Preferences for Executive Resumes (VP, GM, Director, C-Level) 

In the survey, 37% of respondents stated that “length is not an issue as long as the resume provides the 
right data to make decisions”—and 8% actually preferred a 3-page resume, vs. 6% who preferred a 1-
pager! (Only 34% preferred a 2-page resume.) Perhaps most important, 58% of respondents stated that 
they would NOT penalize an executive candidate for having a resume that did not meet their preferences 
(only 5% stated they would do so). 

Ready for a surprise? Several respondents stated that 5 pages was the maximum length they would read! 
Did you hear that, ladies and gentlemen? A 5-page resume! This reality check is a good one for any 
executives attempting to squeeze their resume onto 2 pages. Clearly it is more important to include 
essential information such as achievements and experiences than to meet some mythical page 
requirement. A hard-hitting resume with a compelling message about what the executive will do for a 
company will almost always be read, regardless of length. 

 

http://www.careerdirectors.com/members/docs/hire_survlow.pdf�
http://www.ilostmyjob.com/the-essay-expert/
http://www.careerdirectors.com/members/docs/hire_survlow.pdf
http://theessayexpert.com/blog/what-do-recruiters-want-in-a-resume-answers-within/


Conclusion: It’s not size that matters—it’s content! A hefty 54% of respondents said the length would not 
really matter if the resume were well-written and highly focused. As one stated, “As long as the person 
has a reason for several pages and I can find value in what is written, I don’t care. However, if the 
resume is filled with nothing but job duties on 80 separate lines, it is a waste of space and my time.” (The 
same could be said of a 1-page resume that doesn’t deliver the goods.) 

A more important question than “How long should my resume be?” is “How much should I include about 
my past positions?” The answer to this question depends on the relevance of those positions. It might be 
sufficient to reach back ten years and then stop. However, if your most relevant experience was more than 
ten years ago, don’t hesitate to write about it. Some people write more about older positions than about 
more recent ones because they are targeting a type of position or industry they worked in many years ago.  

There are no rules when it comes to length or how much to include … other than to present information in 
the most effective way for your specific situation. 

 

Tip #6 
Resume Tetris: What Order Should My Resume Be In? 
 

Putting a resume together is like a game of Tetris. You want to create a solid, impermeable block; 
and each piece must fall in the right direction, at the right time, in the right order. Here are some 
how to win the game: tips on 

1. Every resume starts with your CONTACT INFORMATION: Your name, city and state, phone 
number, email address, and LinkedIn Profile URL (See Tip #8 for more on the LinkedIn URL). Do 
NOT put your contact information at the bottom of your resume! Recruiters as well as ATS 
(Applicant Tracking System) programs prefer your contact information at the top, and may not 
bother looking for it at the bottom. This is not the place to get original! You do not need to include 
your street address; city and state are generally sufficient. 
 

2. Choose a HEADLINE that states who you are (e.g. CEO, Director of Marketing, Supply Chain 
Executive, Asset Management Executive, VP Finance, #1 Ranked Medical Device Sales Leader.) 
(See Tip #7 for more on how your headline might look). 
 
IMPORTANT NOTE: If you are submitting to online systems where your resume will be read by 
a computer, you must put the word SUMMARY before this section so the computers will 
recognize the section. 
 

3. Under the headline, you might want to write a brief paragraph, preferably no more than 3 lines, 
describing your most important qualifications and accomplishments (make sure not to use worn-



out phrases like “proven track record” and “team player”! (See Appendix C). You might follow 
this summary with some bulleted HIGHLIGHTS of your accomplishments. 
 

4. If appropriate, write a list of your CORE COMPETENCIES or KEY STRENGTHS or AREAS 
OF EXPERTISE. This can be a bulleted list if you wish, or you may list them with the pipe 
symbol ( | ) or inserted bullets of your choice between them. Use the TAB key to format these 
items. 
 

Here’s what the top of a resume might look like taking into account points 1-4: 

  

5. Your EXPERIENCE section will almost always be the first section after the branding section. 
(Exception: for senior academic positions, Education will almost always come first–and you might 
want to skip the summaries and headlines at the top!) 
 

6. You may then have sections such as TRAININGS & CERTIFICATIONS; PROFESSIONAL 
ASSOCIATIONS; VOLUNTEER ACTIVITIES; PUBLICATIONS; SKILLS & 
INTERESTS; TECHNOLOGICAL SKILLS; LANGUAGES; ADDITIONAL 
EXPERIENCE; PATENTS; BOARD MEMBERSHIPS; or anything else relevant to who you 
are. 
 

7. Do NOT include References unless specifically requested by the organization. Generally, 
references should not be on your resume but instead be listed on a separate document, formatted 
with your resume header. There is no need for the line “References Available Upon Request” at 
the bottom of your resume. It just takes up space. Companies will always request references when 
they want them! 



The key: Relevance! Order things specifically for the position you’re applying for, and you won’t go 
wrong! 

For sample resume arrangements, see The Essay Expert’s sample resumes. Having trouble organizing 
your resume? Contact The Essay Expert at Resumes@TheEssayExpert.com or 608-467-0067 and speak 
to one of our Certified Resume Writers. 

 

  
  

http://theessayexpert.com/samples/resumes-cover-letters-samples/
mailto:Resumes@TheEssayExpert.com


 
 

 

 

SECTION 3 
Content 

  



Tip #10 
The Dangers of “Functional” Resumes – and the Benefits of a “Hybrid” 
 

Most resumes—and those preferred by recruiters and hiring managers—are organized with the most 
recent position first and go backward from there. Under each position is a bulleted list describing what the 
candidate accomplished in that position. 

A “functional resume” is organized as a list of accomplishments without dates, and often without 
attaching the accomplishments to a particular position. 

Recruiters and hiring managers are universally suspicious of these resumes, which are often constructed 
this way in order to hide something.  

A much more accepted format is the “hybrid.” In this format, you list all your employers, positions and 
dates in one section on the first page of the resume; this makes it clear that you are not hiding anything. 
Then you can choose what to expand upon and what to present first. Here’s an example: 

 

This client’s most relevant experience was from 1990-1994. We gave details about this remote position 
before providing details of more recent positions; and in order to allay any concerns that she was trying to 
hide something, we listed her entire work history before anything else. She was successful in obtaining a 
position in OEM, which was her goal. 

There are many ways to present information on a resume; the hybrid format is one option that provides a 
lot of flexibility. If you have a challenging work history, you would benefit from speaking with a 
professional to determine the best way to present your particular situation. 

 



Tip #11 
Create a Compelling Branding Statement and Summary Statement! 
The most important section of your resume is the top third—the part the reader will read first. You must 
grab their attention in 6.25 seconds so that they will read further. 

Using a Tagline 

Tip #7 discussed some of how to craft the top third of a resume. You want a clear headline that states who 
you are and tells your reader that you are qualified for the position. And you might follow that headline 
with a tagline or branding statement. Here are some branding statements my clients have used: 

• Leading Teams to Performance when the Game is on the Line 
• Strategy Architect, Change Agent, and HR Business Partner who blends business acumen 

with distinctive understanding of people and HR Systems. 
• Top-performing marketing executive – Creating compelling campaigns for print and online 
• Decisive top performer with multi-faceted knowledge of Asian business culture and 

processes. 
• Multicultural sensibility – Rigorous accountability – Rapid growth 
• Success Formula for Operational Excellence and ROI: 80% Execution / 15% Position / 5% 

Strategy 
• Change is the only constant and continuous improvement is the only path. Never accept, 

“We have always done it that way.” 

In determining your branding statement, it might be helpful to answer the branding questions provided in 
Tip #3. Often when I work with clients I am able to glean a branding statement from their questionnaire. 
Work personality profiles are another source of information for branding statements.  

One thing is clear: You don’t want your branding statement to sound like anyone else’s, and you don’t 
want it to sound corny. So give it some thought, brainstorm with some people you trust, and don’t settle 
until you love it! 

Writing a Unique, Achievement-Oriented Summary Statement 

The summary statement is possibly the most difficult section of a resume to write. Frankly, there is no 
requirement that you write a summary at all. If you are going to write one that includes general, puffed-up 
terms that make you sound like everyone else, you would do better not to write one. 

Results oriented executive with entrepreneurial spirit and proven track record of blah blah blah... 

Don’t do it! 

Instead, pull in some actual accomplishments, actual names of companies, and as much detail as you can 
of your career highlights, right into the summary. Consider writing not one blocky paragraph, but some 

http://theessayexpert.com/resume-questionnaires/
http://theessayexpert.com/blog/2009/08/03/the-essay-expert-resume-tip-of-the-week-words-to-delete-assisted-helped/


compelling bullets instead. As much as possible, tailor your summary to each job description by 
addressing the job qualifications requested in the job description. Here are some examples: 

  

 

 

 



 

 

 

When you sit down to craft your summary (if you choose to write one at all), ask yourself: Does this 
statement truly define who I am as a valued leader at any organization? If the answer is no, you’re not 
done. If this answer is yes, then ask: Could someone else have written this summary? If the answer is yes, 
you’re not done.  

Keep at it until you have described yourself in unique terms that wake up the person reading. It’s not an 
easy thing to do, but it’s worth it. 

 

  



 

SECTION 4 
Formatting 

Your Resume 



Tip #23 
Why Care About the Format Anyway? 
 
I’ll tell you a story. Not long ago, The Essay Expert worked with a client (I’ll call him Jim) on his 
Executive resume. We gave Jim a nice looking format and he had success in obtaining interviews.  

Jim’s wife (I’ll call her Mary) saw Jim’s resume and liked the format. She liked it so much, in fact, that 
she decided to “steal” it and reformat her own resume, using her husband’s resume as a model. 

The year before, Mary had applied for a job at a university. She was not asked for an interview. 

Mary submitted her newly formatted resume for the same position she had applied for the year before. 
Guess what?  

Yep, you guessed right. She got an interview. 

Was it her new format that did the trick? It’s certainly a possibility.  

Remember, it’s not just computer scanners that read resumes. Humans read them too. You convey a 
certain attitude and impression to your human readers with your resume format. 

Take the time necessary to create a format that you like and that will make the right impression on the 
humans who read it. Giving your format the attention it deserves can make all the difference. 

Click here to see samples of winning resume formats from The Essay Expert. 

If you are applying to jobs on-line through companies that use ATS (Applicant Tracking System) 
programs, format matters a lot! I have included formatting tips for ATS software in Section 6 
(Technology and Social Media), Tip #42.  

 

 

Tip #24 
Don’t Use Templates!  
 
Microsoft Word has many choices of resume templates. I encourage you to LOOK at them. Do not use 
the templates unless one of the following is true: 

a. You want your resume to look like everyone else’s who is using a Microsoft Word template (I 
hope you do not fall into this category!) 

http://theessayexpert.com/samples/resumes-cover-letters-samples/


b. You are VERY skilled with MS Word and can take the template and change it so it doesn’t look 
like the template. 

Option #2 is tricky. The templates in Word are often filled with complex code, tables, columns, etc. For 
example: 

 

One of my clients had used a template from monster.com. The second page had someone else’s name on 
it and the lines forming the border did not intersect properly. Why risk these deadly snafus? 

As you have probably gathered, I highly encourage you not to use templates. Instead, create your own 
resume format. You will avoid the risk of an employer’s recognizing the template. You will also be able 
to edit your resume yourself, which will allow you to tailor it for each job application.  

Here’s a sample resume from Monster.com. It is professional but not unique. 



 

If you do use a resume template, you MUST understand the formatting tools used on the resume so you 
can easily edit it yourself. User beware! 

For more sample resume formats, look at the “After” resume examples on The Essay Expert’s website. 
Find one that meets your experience level and the image you want to portray, and feel free to create 
something similar. 

 

http://theessayexpert.com/samples/resumes-cover-letters-samples/


 

SECTION 5 
Cover Letter 

Tips 
  



Tip #35 
Yes, You Need a Cover Letter!  

Just about every client I work with lately brings up the rumor they’ve heard that no one reads cover letters 
anymore. With the possible exception of highly technological fields and internal promotions, this is 
ONLY a rumor. If you take action based on it, you may shoot yourself in the foot. 

In an article posted on Work Coach Cafe, “15 Job Search Tips from a Guy Who Just Got a Job,” a 
successful job seeker named John relates how the CEO of a company personally reached out to him to 
thank him for sending a cover letter! In fact, John was the ONLY candidate to send a cover letter, most 
likely because everyone else believed the rumor that cover letters never get read. John made an 
impression. 

This topic is also covered in my article, Job Search Myth: You Don’t Need a Cover Letter. The cover 
letter is your opportunity to showcase strengths that you could not highlight within the confines of your 
resume. 

Write a unique letter to the company about who you are and the difference you would make for that 
company. Begin building a relationship right from the start. Imagine yourself in a leadership role at this 
organization and write down what you will bring to the position. Sell yourself. 

You do need to know your target audience. You might need to keep your letter very short and to the point, 
or you might have room to share more about yourself and your accomplishments. If in doubt, keep your 
cover letter short, sweet and focused. 

 

 

http://www.workcoachcafe.com/2010/06/01/15-job-search-tips-from-a-guy-who-just-got-a-job/
http://theessayexpert.com/blog/job-search-myth-you-dont-need-a-cover-letter/


Tip #36 
3 Components of an Effective Cover Letter 

Your ability to present yourself in a cover letter is a test of your ability to communicate effectively as a 
leader. Here are some pointers for presenting a professional image and for conveying a clear statement of 
the value you would add to an organization. 

1. Instead of starting the letter with something about yourself, state what you know about what the 
company needs. For example: 

For a corporation to succeed and expand in Asia, it is essential to have smart decision-
making and global supply chain expertise in place. The complex Asian environment 
requires a person of high integrity to lead business strategy—someone fluent in Mandarin, 
Cantonese and Chinese culture, with an understanding of Chinese labor laws and business 
structures. Someone who can be trusted to handle every facet of the supply chain to create 
value and growth for the company. I offer all the qualities necessary to take on the General 
Manager position at Company, strategically formulate a vision and business plan, then 
execute that plan with detail and precision. 

Do you have a gap in your resume? Explain it in the cover letter: 

It takes a fighter to battle “terminal” cancer and come back to run five Iron Man triathlons. 
I’ll fight for your company with the same gusto I fought for my life. [from Donald Burns]  

2. After you prove you know what the company needs, state why you are a match. List briefly the 
major reasons you are the right candidate for the job. This task can be done in just a few sentences. 
Yes, really, it can! For example: 

My management style has paid huge dividends in Asia for the manufacturing companies I have 
served for the past ten years. Through assessing and identifying people’s strengths, I match them to 
a need in the company and encourage them to take ownership and make a contribution. Value is 
added. Loyalty is created. 

The reader shouldn’t have to wonder whether you’ve got the training and experience for the 
position. Make it clear right away, and give your audience a reason to read further. 

3. Provide bullet points of your top three accomplishments—the ones most relevant to THIS 
position. List them briefly so the reader can get a snapshot of what you can provide to their 
organization. 

http://www.donaldburns.com/


My clients have great success getting interviews, and I know at least part of that success is due to their 
effective, engaging cover letters. 

 

  



 

SECTION 6 
Technology 

& Social 
Media  



Tip #40 
Google Results are the New “Resume” 
 
A simple resume just doesn’t cut it anymore. You need to build a strong on-line presence so you look 
good when someone punches your name into the Google search bar. 

Ways to do this: 

1) Have a 100% LinkedIn profile that is professional and full of keywords. Learn more about How to 
Write a KILLER LinkedIn® Profile. 

2) Clean up your Facebook page. That means no pictures of you within 100 yards of a beer! (Did you 
know that studies show people are judged as less intelligent when holding an alcoholic 
beverage?!) 

3) Establish a Twitter account and tweet useful information about your field of work. 
4) Create a website for yourself! Post your on-line resume there and stock it with keywords. 
5) Create a PowerPoint-based resume and upload it to SlideShare. See Dreamcss's 30 Best Visual 

PowerPoint Résumés for Your Inspiration for examples. 
6) Start a blog and write something at least once/week. People with blogs are seen as leaders and 

doers. The topic is up to you as long as it’s professionally appropriate. 
7) Post a professional video on YouTube. YouTube has high search rankings and will have your 

video show up in Google searches. 
8) Search for yourself on Google and see what happens. Is there anything there that looks less than 

pristine? If so, clean it up. It WILL keep you from getting hired. 

Yes you still need a resume. Just about every hiring entity will ask for one in some form or another. But 
build your Google brand too.  

Check out The Essay Expert’s Google results. The results change every day! 

 

Tip #41 
PowerPoint and Video Resumes  
 
Calling all armchair graphic designers and creative people of all sorts!!! I’ve got great news for you: You 
can create a PowerPoint or video resume in addition to your standard “vanilla” resume! 

How cool is that? 

http://theessayexpert.com/how-to-write-a-killer-linkedin-profile-e-book/
http://theessayexpert.com/how-to-write-a-killer-linkedin-profile-e-book/
http://theessayexpert.com/how-to-write-a-killer-linkedin-profile-e-book/
http://theessayexpert.com/how-to-write-a-killer-linkedin-profile-e-book/
http://blog.dreamcss.com/tech/30-best-visual-powerpoint-resumes/
http://blog.dreamcss.com/tech/30-best-visual-powerpoint-resumes/
https://www.google.com/search?q=the+essay+expert


 

If you read the previous tip, you know that Google results are the new resume. How can you get your 
resume to show up on Google results? That’s where PowerPoint, SlideShare and YouTube come in. 

PowerPoint 

For more samples of PowerPoint resumes, read 4 Steps to Creating a Visual Resume That Stands Out. 
These folks have used uniquely creative methods to market themselves by means of their resume. 
Through a combination of language and graphics, they have set themselves apart from the competition: 
they have shown they are willing to go the extra mile to get noticed and produce outstanding results. 

Don’t you want to be one of them? If so, don’t wait another second. Open up PowerPoint on your 
computer and get to work! 

Need help publishing your PPT presentation to SlideShare? 

Read LinkedIn Help Center's SlideShare - Frequently Asked Questions.  

Video Resumes 

Video resumes are becoming more and more viable as a way to present yourself to potential employers. 
Many hiring managers would rather watch a 3-minute video than read through yet another resume. 
However, according to a September 2015 article by Recruiter.com, a standalone video resume will not get 
you hired on its own. It’s important to present a consistently branded multimedia package to succeed in 
leveraging the power of video and other technology in your job search. 

Branding expert Alex Kecskes states in his article Video Resumes: Should You Use Them? Do They 
Work? that "once the CD disk, thumb drive or other media is viewed, your personality, poise, speaking 
skills and overall demeanor are evident immediately." This can be both good and bad. Mistakes can be 
edited out, but if you're not comfortable in front of a camera, awkward body language could cost you an 
interview, and although illegal, potential discrimination based on appearance or dialect may also occur. 

http://blog.slideshare.net/2013/10/14/4-steps-to-creating-a-visual-resume-that-stands-out/
https://help.linkedin.com/app/answers/detail/a_id/53685/kw/slideshare
https://www.recruiter.com/i/is-a-standard-resume-enough-to-get-you-an-interview-anymore/
http://www.care2.com/greenliving/video-resumes-should-you-use-them-do-they-work.html
http://www.care2.com/greenliving/video-resumes-should-you-use-them-do-they-work.html


If you do choose to create a video component to your job search profile, make sure to keep it clear and 
short (ideally, about 2 minutes) and point to that video clearly from your resume and LinkedIn profile. 
Use consistent imaging and branding: Say or show something that differentiates you. “Multimedia 
resumes work best when they are part of a broader campaign,” according to the Boston Globe, 
paraphrasing John Wilpers, founder and chief executive of Degrees2Dreams. This campaign “should 
include a blog about a niche in your professional field, personal marketing through social media, and a 
series of informational interviews.” 

So be careful if you jump on the multimedia bandwagon. It’s not for everyone, it takes a lot of work, and 
it must be done well to pack a punch. Also keep in mind that many large companies won't accept video 
resumes, preferring to utilize resume scanning technology to pre-filter the best candidates. 

For more help on deciding whether to use a video resume, see Robert Half's article, Is a Video Resume 
Right for You? 

 

 

http://www.roberthalf.com/blog/is-a-video-resume-right-for-you
http://www.roberthalf.com/blog/is-a-video-resume-right-for-you


SECTION 7 
The #1 Most 

Important 
Tip Set! 



Tip #47 
How to Avoid Embarrassing Editing Marks on Your Documents 
MS Word’s Track Changes Program 

Have you ever gotten a document back from an editor with tons of red or blue lines (maybe even some 
green ones), and have no idea how to get rid of them all, or view the document the way it’s supposed to 
look? This tip is for you!  

Don't Submit a Document that Looks Like This! 

 

Why I Love Track Changes 

Microsoft Word has a very useful feature called “Track Changes” that keeps track of changes that an 
editor makes to a document, and allows subsequent readers to see what changes were made. When the 
“Track Changes” feature is turned on, anyone who opens the document can see every change made to the 
original document, whether to fonts, page formats, margins, and text. 

Track Changes also has a “Comments” feature that allows explanations and suggestions to be entered in 
the margins of your document. 

The value of Track Changes to me as an editor is that my clients can see what I’ve changed, and I can see 
the changes they make. I do not then have to go through their resume word by word to see what 
alterations have occurred. Accepting or rejecting changes is easy and does not require changing individual 
fonts or colors. Gone are the days of manually inserting a strikethrough to indicate a deletion! 

If you are working with someone on your resume, and they send you a set of edits, I recommend 
accepting them and then tracking the changes you make. This system makes it easy for both parties to 
keep track of what’s being changed, and avoids the necessity of reading the entire resume to find any 
changes. 



The Dangers of Track Changes 

Track Changes can be troublesome too. You don’t want to send a document with lots of red lines and 
bubbles all over it to an employer or a school (many people have embarrassing stories of doing this)! The 
recipient then sees all the suggestions, changes, and possibly the original language and mistakes that 
needed changing. 

As part of proofreading and preparing the final draft of a resume, cover letter, or essay, take the following 
steps to ensure that you do not inadvertently send a marked up copy to an employer: 

Directions for MS Word 2007/2010 

 

Review Tab 

1)  Check to see if there are any comments or tracked changes in the document: 

• Go to the “Review” tab and click on the window that says “Final Showing Markup.”  Go to the 
“Show Markup” menu and make sure there are check marks in all the boxes (otherwise you might 
not see the comments or formatting changes when you look at “Final Showing Markup”). 
 

• NOTE: If the window says “Final” and you do not see any red lines, this does not mean they are 
gone! Make sure you are viewing the markups before determining that your document is clean. 

2)  If you do not see any changes or comments and you do not make any other changes to the document, 
you’re good to go. 

3)  However, if you do see comments and tracked changes, you can do one of two things: 

a. Change “Final: Show Markup” to “Final” and save the final document as a PDF. This solution 
works if the place you’re submitting your resume accepts .pdf files. 

b. Accept all the tracked changes and delete all edits and comments (unless you only want to accept 
some of them, in which case see step 4). NOTE: You need to delete edits SEPARATELY from 
comments! 

• Under the “Review” tab, go to “Accept” icon and accept all changes. 

• Under the “Review” tab, go to the icon that says “Delete” (next to the “New Comment” icon, and 
click “Delete All Comments in Document.” 



4)  If you want to accept some changes and delete others, you can accept or reject changes and comments 
one at a time by right clicking on them individually. You will get a drop-down menu with choices of what 
to do. 

5)  Repeat Step 1. 

Directions for MS Word 2003 

1)  Check to see if there are any comments or tracked changes in the document. 

• Go to the “View” menu and click on the “Markup” option. This feature can be switched on or off. 
On the Reviewing toolbar, click Show, and then make sure that a check mark appears next to each 
of the following items. If a check mark does not appear next to an item, click the item to select it. 

1. Comments 
2. Ink Annotations (Word 2003 only) 
3. Insertions and Deletions 
4. Formatting 
5. Reviewers (Point to Reviewers and make sure that All Reviewers is selected.) 

• When on, you will see all the comments and changes. When off, you will see the document in its 
final form. Note: the default setting may be set to “off.” Therefore, never assume your final 
Word document does not contain any hidden comments or changes!!! 

2)  Get rid of all the redlines and comments (you must delete edits and comments separately). Do this in 
one of two ways: 

a. Turn off the View Markup option and convert the final form of the document into a PDF. You can 
use a program such as Primo PDF. 

b.  In the View menu, point to Toolbars, and then click Reviewing. 

• On the Reviewing toolbar, click Next to advance from one revision or comment to the next. Click 
Accept Change or Reject Change/Delete Comment for each revision or comment. Repeat until all 
the revisions in the document have been accepted or rejected and all the comments have been 
deleted. 

OR 

• To accept all the changes, click the arrow next to Accept Change, and then click Accept All 
Changes in Document. If you know that you want to reject all the changes, click the arrow next to 
Reject Change/Delete Comment, and then click Reject All Changes in Document. 

• THEN, to remove ALL comments, click the arrow next to Reject Change/Delete Comment, and 
then click Delete All Comments in Document. 

http://www.primopdf.com/


• If you want to accept SOME changes and delete others, you can accept or reject changes and 
comments one at a time by right clicking on them individually. You will get a drop-down menu 
with choices of what to do. 

3)  Repeat Step 1. 

Important notes for both MS versions of Word:  

1. If you accept all changes before reviewing the document and there is a comment in the middle of 
your document like “(dates?)” then that change will be accepted and become a part of your 
document! Make sure you respond to all questions and make any revisions needed inside your 
document before accepting all changes. 
 

2. *ALWAYS* proofread your final document at least 3 times! As much as The Essay Expert and 
other editors attempt to ensure that your documents are perfect, final approval is ultimately your 
responsibility. 
 

3. If you don’t want all your future edits to show up as marked on your document, turn Track 
Changes off by clicking on it. It’s a toggled function. Click it on, click it off. 
 

4. Finally, when you receive an edited document, whenever possible accept or reject the changes 
before making your own edits! This practice will make it much easier to look at the NEW edits 
you have made to the document. 

 

Tip #48 
Proofread, and Proofread Again! 
 
Yes, this is the grand finale! You would be amazed how many grammatical and typographical errors show 
up in “finished” resumes. I reread every resume I write multiple times, and have my client and another 
resume writer look over the document as well. There is a LOT of information in a resume, and just as 
many opportunities to get something wrong. 

Here are ten essential spots to examine carefully before submitting your resume to an employer: 

1. Address, phone and email. Although it’s unlikely you have misspellings in any of these key 
areas, it can happen, so check them carefully! Perhaps you changed a phone number or email 
address and forgot to change it on your resume? Make sure your address, phone and email are both 
correct and up-to-date! If you are in a technology field, use a Gmail address or paid account and 
stay away from Hotmail and Yahoo. 
 



2. Section headings. Have you checked the spelling of the word Achievements (I have seen senior 
executives’ resumes where the heading is spelled Acheivements)? How about Experience and 
Activities? Are there any extra letters floating around? Did you correctly spell Extracurricular (I 
have seen Extracaricular). Not only could errors like these turn off a hiring manager who notices 
them, but they could prevent an ATS system from recognizing an entire section of your resume. 
 

3. Job titles. One of the most commonly misspelled words on resumes is “Manager” (often spelled 
“Manger”). Check your job titles to make sure they are spelled correctly! Also, in all your 
correspondence, make sure to refer to the exact job title listed in the job announcement. Do not 
abbreviate! Why take chances? 
 

4. Verbs. “Led” is the past tense of “Lead” (many people mistakenly write “Lead”). Make sure 
you’ve spelled it correctly. If you are repeating your verbs over and over in your bullets, see what 
you can do to vary your verbs. Your resume will truly start to shine. Finally, make sure your past 
jobs use past tense verbs. Often when someone converts a present job to a past job, some of those 
verbs remain in the present tense. This applies to ALL verbs in the section, not just the ones that 
start each bullet. For more tips on varying your verbs, view my webinar, Top 10 Ways to Make 
Resume Writing FUN! 
 

5. Format. Do all your bullets and dates line up with each other? Do you use the same font and font 
size throughout your resume (unless you have an artistic, consistent reason for using two different 
fonts)? Is your spacing even? Are your headers all formatted the same way? If not, you have some 
cleaning up to do! 
 

6. Dates. Line up all your dates format-wise and use consistent formatting (don’t write 1/06 to 2/05 
in one spot and 3/2008-4/2011 in another; don’t write December 2004 in one spot and Dec. 2006 
in another). Check that all dates are accurate, with proper months and years, listed in reverse 
chronological order. 
 

7. Document Properties and Tracked Changes. If someone else assisted you with your resume, 
there might be tracked changes and document properties still lurking. To clean up tracked changes, 
accept all changes and delete all comments. Want more detailed instructions? Check out Tip #49, 
or my article, How to Avoid Embarrassing Editing Marks on Your Documents! To delete 
document properties such as Author, go to the File tab, click on Check for Issues and then Inspect 
document. Follow the prompts and your document will be cleaned of whatever information you 
choose. 
 

8. Consistency between cover letter and resume. Match your cover letter format, including header 
and font, to your resume format. Consistency matters to recruiters and hiring managers! 
 

http://www.ilostmyjob.com/the-essay-expert/
http://www.ilostmyjob.com/the-essay-expert/
http://theessayexpert.com/blog/how-to-avoid-embarrassing-editing-marks-on-your-documents-ms-words-track-changes-program/


9. Additional instructions. Did you supply all the information and documentation requested by the 
employer in the job description, in exactly the way it was requested? Following instruction is one 
of the most important parts to a successful job application! 
 

10. How does it look in PRINT? Yes, I suggest PRINTING out your resume and reading it on paper. 
You might be surprised what you find! 

Once you are absolutely sure there are no errors in your resume, go through the checklist in Appendix D 
one item at a time. Then run it by at least three trusted friends and colleagues to see if they find anything 
you missed! Once they’ve approved of the resume, start applying to your dream jobs!  

 
  



Thank you!  
We hope you’ve enjoyed this preview of How to Write a STELLER Executive Resume. There are 36 more 
tips, as well as additional resources, in the complete book! You can get the full version for your Kindle 
directly from Amazon (note: the graphics are much sharper on the Kindle version). 
 
H ere's what you'll get with the full version: 

Foreword 

About the Author 

Introduction 

SECTION 1 Context 

Tip #1 Write for the FUTURE 

Tip #2 Know Your Target. 

Tip #3 Know What Makes You Stand Out 

Tip #4 Gather Information First 

SECTION 2 Getting Started 

Tip #5 How Long Should My Resume Be? 

Tip #6 Resume Tetris: What Order Should My Resume Be In? 

Tip #7 Crafting Your Resume Header – Don’t Use an Objective! 

Tip #8 Customize Your LinkedIn URL 

Tip #9 Use a Professional Email Address 

SECTION 3 Content 

Tip #10 The Dangers of “Functional” Resumes – and the Benefits of a “Hybrid” 

Tip #11 Create a Compelling Branding Statement and Summary Statement! 

Tip #12 Delete These Words and Phrases from Your Resume 

Tip #13  Make Your Boring Resume Bullets Sparkle!  

Tip #14 Focus on Accomplishments. 

http://www.amazon.com/gp/product/B00F05W9I6/ref=as_li_qf_sp_asin_tl?ie=UTF8&camp=1789&creative=9325&creativeASIN=B00F05W9I6&linkCode=as2&tag=wwwtheessacom-20


Tip #15 Tailor Your Resume Bullets 

Tip #16 Should I Have a Skills & Interests Section? 

Tip #17 Should I Have a Separate Languages Section? 

Tip #18 Consider Including a Chart, Graph or Testimonial 

Tip #19 “I” vs. “We” 

Tip #20 Special Issue: Filling a “Gap” 

Tip #21 Special Issue: For "Older" Job Seekers 

Tip #22 Special Issue: More than One Position at the Same Company 

SECTION 4 Formatting Your Resume 

Tip #23 Why Care About the Format Anyway? 

Tip #24 Don’t Use Templates! 

Tip #25 Don’t Use a Column Format 

Tip #26 Keep it Simple 

Tip #27 Use the Borders Function to Create Lines 

Tip #28 How to List Dates of Employment 

Tip #29 Don’t Format with the Space Bar! 

Tip #30 How to Create Distinctive, Professional Bullets 

Tip #31 Guidelines for Margins 

Tip #32 How to Use Page Borders 

Tip #33 Spacing 

Tip #34 Hyperlinks are Welcome! And So are Word Documents 

SECTION 5 Cover Letter Tips 

Tip #35 Yes, You Need a Cover Letter! 

Tip #36 3 Components of an Effective Cover Letter 

Tip #37 Delete These Words from Your Cover Letter! 

Tip #38 “To Whom it May Concern” Doesn’t Cut It 

Tip #39 Writing a Value Proposition Letter 

SECTION 6 Technology & Social Media 

Tip #40 Google Results are the New “Resume” 

Tip #41 PowerPoint and Video Resumes 

Tip #42 How to Beat the Scanners Part 1: 5 Essential Resume Keyword Tips 



Tip #43 How to Beat the Scanners Part 2: Formatting Tips 

Tip #44 LinkedIn-Savvy 

Tip #45 QR Codes on Resumes? 

Tip #46 Send a Hard Copy! 

SECTION 7 The #1 Most Important Tip Set! 

Tip #47 How to Avoid Embarrassing Editing Marks on Your Documents 

Tip #48 Proofread, and Proofread Again! 

Tip #49 Get Your Resume Out There! 

Tip #50 It Doesn’t End Here. On to the Interview! 

Appendices – Resources for You 

Appendix A: POWER VERBS FOR RESUMES 

Appendix B: FAVORITE RESUME VERBS (397 of them!) 

Appendix C: Words to Avoid in Your Resume!! 

Appendix D: Resume & Cover Letter Checklists – Don’t Skip Over These!! 

Appendix E: Services & Special Offers 

Appendix F: Recommended Resources 

Appendix G:  Important Opportunities to Give and Receive 

  
Check Out Our Services 

If you think you might benefit from The Essay Expert’s resume writing or LinkedIn services, please 
contact TEESupport@TheEssayExpert.com or through our web form, or call us at 608-467-0067. We 
look forward to working with you! 

 
Contact Us 

Did you know that when you purchase the full version of this e-book, you get access to the following 
exclusive discounts? 

o $150 off any resume package worth $2397 or more 
o $100 off any resume package priced between $1447 and $2396 

 
Here's what people are saying about The Essay Expert’s Resume Services: 

http://theessayexpert.com/services-rates/resume-and-cover-letter-writing/#tab-1
http://theessayexpert.com/services-rates/linkedin-profiles/
mailto:TEESupport@TheEssayExpert.com
http://theessayexpert.com/contact-us/
http://theessayexpert.com/contact-us/


"I worked with The Essay Expert on condensing 4 pages and 24 years of professional experience down to 
a succinct 2 page Executive Resume. Brenda was instrumental in helping me land my new CEO position. 
I highly recommend her services to any professional seeking a job change." 

- R.K., President / CEO, Code Violation Services, Inc., Denver, CO" 

 

"This was by far the most professional C.V. rewrite on which I have ever engaged a hired team. I saw an 
immediate and dramatic improvement in the quantity and the quality of inquiries and invitations to 
interview, and I accepted an offer as VP of Global Marketing after just 2 months. Worth every dime." 

- S.I., Chief Marketing Officer, Chicago, IL 

 

“The feedback from recruiters and hiring managers on my new resume has been quite amazing. It’s hard 
to believe, but the traction I have received since publishing the new version two weeks ago has but me in 
the running for 5 positions. It might have been timing, but I think it’s the new resume." 

- S.B., Global Sourcing Executive, Los Angeles, CA 

 

"It more than paid off to have an executive resume that was professionally done. I was offered and 
accepted a full-time Director of Development position with a prominent non-profit organization in New 
York City. This position has increased my salary by $50,000 and I am seen as an expert in the field. I 
attribute much of this to our work together." 

- F.B., Non-Profit Executive, New York, NY 

 

I was offered an Executive Director position at A Safe Place and I accepted it! I am excited for this new 
beginning in my life, and I want to thank you for helping me make this a reality. Your excellent writing 
skills created a phenomenal resume that got me noticed. I never had to look for a job using a resume 
before, and I was lucky to have you in my corner helping me with my job search. THANK YOU!!!!! 

- P.D., Non-Profit Executive Director, Zion, IL  

 

Get on My Lists 

Want news and updates from The Essay Expert? Sign up for my Job Search list. You will receive a free e-
book preview that you can give to a friend! 



 
Weekly Blog 

Connect with The Essay Expert on Facebook 

“Like” our Facebook Fan page now to connect with other readers and additional resources ... 

 
STELLAR Facebook Fan Page 

And of course, please Connect with me on LinkedIn! 

 
Brenda Bernstein on LinkedIn 

 

Thank you! Here's to your success as you craft a STELLAR 
Executive Resume! 

 

 

http://forms.aweber.com/form/58/584588858.htm�
https://www.facebook.com/executiveresumetips/�
http://www.linkedin.com/in/brendabernstein�
http://theessayexpert.com/subscribe-to-the-weekly-blog/
https://www.facebook.com/executiveresumetips/
http://www.linkedin.com/in/brendabernstein
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